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Chapter 1 Introduction

This chapter includes:
Section 1: Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Section 2: User Groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Section 3: Documentation Conventions . . . . . . . . . . . . . . . . . . 10

Section 4: Acronyms and Abbreviations . . . . . . . . . . . . . . . . . . 10

Section 1: Overview

The most important part of the planning process is getting feedback 
from external participants to develop a better understanding of 
demand. Sharing information and managing Exceptions is the key to 
developing a productive relationship with customers and suppliers to 
develop a demand-driven supply chain. The Planning Portal provides 
the foundation for capturing input to take the planning process to the 
next level. It is directly integrated into the Demand Management 
Engine so existing configurations are leveraged to a maximum 
benefit. 
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The figure below is a depiction of the Atlas Planning Suite. The 
Planning Portal encompasses the products of the suite.

1-1: Planning Portal Highlights

 Supports different Views, including hierarchies

 Makes changes to the forecast

 Add Sales Promotions

 Add New Item(s)

 Retag Items (Item super cession)

 Add or Edit Notes
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1-2: Logging In

The Planning portal can be accessed using the following default web 
address:

http://(ServerName)/planningportal/viewer.aspx

Note: If you cannot log in using the default site address please contact your 
system administrator.

1. Enter your User Name and Password in the corresponding text 
boxes.

Note: Usernames and passwords are case sensitive.

2. Select either “Windows authentication” or “Planning Portal 
authentication” option under the “Login using:” area.

Planning Portal authentication is used when you want to log into 
each session. Windows authentication enables you to bypass the 
Planning Portal login as long as you are logged into your system 
with the correct account.
Rev 1 8
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3. Select the Scenario you want to view in Planning Portal from the 
drop-down list.

4. Use the Default Language drop-down to choose the language file 
you want to use in Planning Portal. The default selection is 
“English (United States)”.

5. Check “Save Login Info” if you would like your username and 
password to be saved. This option is only available if you have 
selected “Windows authentication”.

6. Click Submit.

You can also click Reset to clear the user name and password 
that were saved. It is recommended that you use this option when 
using a public computer in your office.

Please contact your System Administrator if you forgot or do not 
have a username and password.

1-3: Logging Out

If you would like to log out of the application, click the Logout button 
in the top-right corner of the screen. If you logged in using the 
Windows authentication and want to use the application without 
logging in, you should not log out of the application. Rather, close the 
application and you will be logged in automatically the next time you 
access the Planning Portal.

Section 2: User Groups

User Groups and privileges are dependent upon the permissions 
granted by your System Administrator. The System Administrator 
configures the Planning Portal interface for individual users or user 
groups. Please contact your System Administrator if you have 
questions about your user privileges.
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Section 3: Documentation Conventions

3-1: Text 

Table 1-1: Text Convention Descriptions 

Convention Description

Text represented as a screen display. The following typeface represents displays that appear 
on your terminal screen, such as:

lom>

Text represented as menu or sub-menu 
names.

This typeface represents all menu and sub-menu 
names within procedures, for example:
On the File menu, click New.

The following table lists text conventions utilized in this user guide.

3-2: Screen Captures

The example screens in this guide may not represent what you see 
on your monitor and should only be used as guidelines.
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Section 4: Acronyms and Abbreviations

Table 1-2: Acronyms and Abbreviations used in this Manual

Term Definition

DME Demand Management Engine

PP Planning Portal

DB Database

IIS Internet Information Services

OL Opinion Line
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Chapter 2 Using the Planning Portal

This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Section 2: Home Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Section 3: My View Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Section 4: Data Browsing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Section 5: Detail View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Section 6: Summary View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Section 7: Classic View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Section 8: Planning Portal Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Section 9: My Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Section 1: Overview

The Planning Portal enables you to access your scenarios remotely using 
a web interface. Using this interface, you can view, edit, and commit any 
changes to the scenario. This chapter details the Planning Portal's 
features and how to access them.
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Section 2: Home Page

The Home page for the Planning Portal is a customizable workspace that 
allows you to see an overview of your data in a concise manner. The 
Home Page will be the first screen displayed upon logging in to the 
Planning Portal and can always be accessed by clicking the “Home Page” 
link in the upper left corner of the page.

There are several different panels available to be displayed on the Home 
Page and the bars at the left allow you to select which of these panels are 
displayed. Most of these panels are for display only, but Planning Portal 
does allow you to customize the information displayed in each panel. This 
feature is done on the Settings page which is discussed later in this guide.

The bars on the left-hand side of the screen are used to control which of 
these panels are displayed. Click any of the bars to display the 
corresponding panel on your Home Page. If the bar is selected, it will 
display in orange. To remove a panel, click the bar again and it will display 
in blue again. You can display as many panels as you would like and they 
are displayed on the Home Page in the same order as the bars.

This section will describe each of the panels and the options available for 
each one.

Also, note that the Quick Start bar does not display a panel on the Home 
Page. This link expands to display quick reference links and access to the 
Planning Portal user guides.
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2-1: My Workflow

The first available panel is “My Workflow”, which allows workflow status to 
be captured and viewed for all users accessing the Portal. This gives 
users the ability to communicate their status for the current forecast cycle.

This window can be expanded and collapsed by using the arrow on the 
right side of the tool bar. If all the available users cannot be viewed in the 
panel, click the linked number in the bottom right corner of the panel to 
view the next page.

The toolbar also shows the status for the current user. The status options 
available and permissions to view other users’ status are configured in the 
Planning Portal Admin tool. (See PP Super User Guide).

To change the status, select the check box for the task and click the 
“Change Status” link at the bottom of the panel. The following window 
displays, allowing you to select a new status for your forecast:

Add any comments and click the Update icon next to the drop-down. The 
status is updated and displays on the My Workflow panel.
Rev 1 17
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2-2: My Reports

The My Reports panel displays options for any reports you have created, 
and provides a link to that report. Reports are created using the “My 
Reports” tab on the My Settings page.

The My Reports panel is used to view the available reports and viewing 
the latest version of the report. Reports cannot be added, modified, or 
deleted from this panel. Click the link in the “Link Report” column to 
generate and view the report.

For additional information in regard to creating reports, see Section 8-2: 
Reports.

2-3: My Notes

The My Notes panel displays all notes assigned to the current user. 
Users can set the criteria for which notes are displayed in this panel in the 
My Settings section of Planning Portal. For additional information in 
regard to displaying notes, see Section 9-2: My Notes.

If all the available Notes cannot be viewed in the panel, click the linked 
arrow in the bottom right corner of the panel to view the next page.
Rev 1 18
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2-4: My Shortcuts

The My Shortcuts panel allows you view or delete the custom shortcuts 
you have created. Shortcuts are a saved group of settings that you can 
use for specific data that you may need to view frequently. Shortcuts are 
created in the My View portion of Planning Portal and are further 
discussed in Section 9-3: My View of this guide. My View is available from 
the Home page or under the My Settings tab.

A shortcut allows you to select criteria such as scenario, field view, and 
date range, apply a filter, add an exception and then save this 
combination of settings. This saves you from having to select these 
criteria individually every time you want to view this data.

Once the Shortcut has been created, it will display in the My Shortcuts 
panel on the Home Page.

Click the “Go” link in the Load column to run the shortcut and display the 
data in the selected view. Click the trash can icon in the “Delete” column 
to remove the shortcut.

If all the available Shortcuts cannot be viewed in the panel, click the linked 
arrow in the bottom right corner of the panel to view the next page.

2-5: My Exceptions

The My Exceptions panel displays a list of exceptions available to the 
current user. Exceptions enable users to select items based on the 
numerical information that is stored in Observations. 
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Exceptions can be added and modified on the Exceptions tab in the My 
Settings section of the Planning Portal. For more information on adding 
Exceptions, refer to Section 9-8: Exception of this guide.

Click on the “Refresh” link to run an Exception. The Exception is applied 
and displayed in the selected view. You can view your Exceptions in the 
My Exceptions tab under My Settings.

2-6: My Charts

The My Charts panel allows you to view a graphical representation of the 
data in a variety of formats. Two charts can be displayed in this panel at 
one time, and the drop-downs above each chart allows you to select 
which charts to display. If the user only has one chart created, it will 
display in the My Charts panel twice. 

The criteria and settings for these charts can be selected in the My 
Settings portion of Planning Portal and are further discussed in Section 
9-6: My Charts later in this guide.
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2-7: My View Settings

These fields allow you to access different views and settings that are 
pertinent to how data is displayed on screen.

Below we describe the tabs available on the Data View Settings feature.

Tab Description

Shortcut Indicates the current shortcut. Click the Save As 
button to save these settings as a new shortcut.
Rev 1 21
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Type You can view the Data View in three different ways:
 Classic - This is the simplest way to display your 

data one series at a time.
 Detail - This is the best view when using 

hierarchies; it displays the tree view, graph and data 
all within the same screen.

 Summary - This view is helpful when trying to make 
mass changes to your series.

Filter Select the filter (if any) to apply to this view when it is 
displayed. Only currently saved filters will display in the 
drop-down and new filters cannot be added here.

Exception Select the exception (if any) to apply to this view when 
it is displayed. Only currently saved exceptions will 
display in the drop-down and new exceptions cannot 
be added here.

Mode Use this field to select the type of Hierarchy to apply, if 
any. The available options are:

 None - Do not apply a hierarchy.

 Static - Static hierarchies are usually applied 
within the DME Viewer. If a scenario already 
has a static hierarchy applied to it, you can 
use this option to view the aggregated data.

 On Fly - On Fly hierarchies are the preferred 
way of aggregating your data. Use this option 
to apply hierarchies quickly and view data at 
higher levels.

Depending on the permissions assigned to your user 
account, hierarchies may not be available to you.

Hierarchy Use this drop down list to select the specific hierarchy 
to be used to view your data.

Depending on the permissions assigned to your user 
account, hierarchies may not be available to you.

Tab Description
Rev 1 22
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Show Hierarchy Use this check box to indicate whether or not to display 
the data in the Detail View using a tree format if the 
level in the Tree Level option is not the lowest level in 
the hierarchy.

Level This field is used to select the tree level at which the 
hierarchy will be applied. Once a hierarchy has been 
selected from the Hierarchy drop-down, this field will 
populate with all the available levels for the selected 
hierarchy.

Depending on the permissions assigned to your user 
account, hierarchies may not be available to you.

Conversion This selection defines the unit of measure for the 
display: 

 Units
 Any Conversion factor already configured

For example, if you have a price for an item and would 
like to view the price in dollars, you can do this by using 
View By to convert to price.

Field View Enables you to select the Field View and if you have 
multiple Field Views assigned, you can select a 
different one. 

Field Views are assigned to you by your administrator 
and you can create your own customized Field Views 
on the My Settings tab. This feature is explained in 
more detail in the section titled “Field View” on page 86 
of this guide.

Cmd Bar Show Use this check box to indicate whether or not to display 
the Command Bar. The Command Bar is a tool bar at 
bottom of the Summary view which gives you access 
to Cut, Copy and Paste functionality.

Tab Description
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2-8: Quick Start

The bottom bar at the left-hand side of the Home Page is used to access 
the PP Quick Start Guide. Clicking this bar does not add a panel to the 
home page, but instead will expand to display a list of links to different PP 
features. This list includes brief overviews of different functionality within 
PP, as well as links to online versions of the PP User Guides.

Data View Enables you to select the Data View, or if you have 
multiple Data Views assigned, select a different one.

Data Views are assigned to you by your administrator 
and you can create your own customized Data Views 
on the My Settings page. This feature is explained in 
more detail in the section titled “Data View” on page 88 
of this guide.

Order Enables you to sort your data in ascending or 
descending order based on the selected data field. 
Select a field from the drop-down and use the radio 
buttons to change the sort order.

Show Calendar Enables you to set everything to a month offset. Use 
the negative values to indicate historical data.

Start Date The first date to include in the view.

End Date The final date to include in the view.

Tab Description
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For example, if you click on the arrows in the Filtering bar, the bar 
expands with additional information:

Click on the arrows again to collapse the bar. PP allows you to expand 
multiple sections of the Quick Start section simultaneously.

2-8-1: Planning Portal User Guide

On the bottom left-side of the Quick Start section is the Help panel, which 
allows you to access the latest version of this guide by clicking the User 
Manual link.
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Section 3: My View Settings

The My View settings essentially drive the data viewing portions of the PP 
interface by determining what data is displayed. These settings are used 
to indicate the type of data being displayed, the time frame for the current 
view, and whether or not any filters or exceptions are applied to the data.

The My View panel is available on all three data views, as well as the 
Home Page and My Settings tab. From the Detail, Summary and Classic 
views, users can make changes to the view and immediately apply them 
to update the data currently being displayed. Users can save My View 
settings as a shortcut from the Home page or from the My View tab under 
My Settings.

Note: Please note that some options in the My View panel are assigned by your 
System Administrator and may not be available to all user accounts.

The picture above represents the My View panel on the Home Page. The 
My View panels on the view screens do not utilize the “Shortcut” or “Type” 
fields, but the remaining fields are the same. Also, the My View panels on 
the view screens will show the Apply button rather than the Save and 
Save As buttons shown above.
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3-1: Shortcut

Indicates the current shortcut. Click the Save As button to save these 
settings as a new shortcut.

3-2: Type

You can view the Data View in three different ways:

 Classic - This is the simplest way to display your data.

 Detail - This is the best view when using hierarchies; it displays the 
tree view, graph and data all within the same screen.

 Summary - This view is helpful when trying to make mass changes to 
your series.

3-3: Filter

Select the filter (if any) to apply to this view when it is displayed. Only 
currently saved filters will display in the drop-down and new filters cannot 
be added here.

3-4: Exception

Select the exception (if any) to apply to this view when it is displayed. 
Only currently saved exceptions will display in the drop-down and new 
exceptions cannot be added here.

3-5: Mode

The Planning Portal allows you to aggregate your data using hierarchies. 
If the scenario you are logged in to has a Static hierarchy this will be 
indicated on the top right corner of the Planning Portal.

You can also use On Fly hierarchies by selecting this option from the 
Mode drop-down list. With an On Fly hierarchy, you will be able to view 
the data for all levels from any view type.
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Note: If the “Show Hierarchy” option is enabled and the highest level of the 
hierarchy is selected from the Level drop-down, then only the Detail View 
Type will display your series in a tree structure.

The Mode field allows you to select the type of Hierarchy to apply, if any. 
The available options are:

 None - Do not apply a hierarchy.

 Static - Static hierarchies are usually applied within the DME 
Viewer. If a scenario already has a static hierarchy applied to it, 
you can use this option to view the aggregated data.

 On Fly - On Fly hierarchies are the preferred way of aggregating 
your data. Use this option to apply hierarchies quickly and view 
data at higher levels.

Note: Access to Static and On Fly hierarchies need to be given by system 
administrators. If you do not have this feature, talk to your system 
administrator.

Static hierarchies must be removed by the owner of the scenario, but On 
Fly hierarchies allow you to switch from one hierarchy to another as 
needed. You will be able to change your hierarchy settings in any Data 
View using the My View panel, and your changes will be saved for the 
next time you open the Data Browser.

3-6: Hierarchy

The Hierarchy field is used to select the individual hierarchy to apply to 
your scenario. This field is populated based on the selected Mode and will 
display the hierarchies available to your user account.

Hierarchies are created in the DME Viewer and can be assigned to 
individual user accounts.

All three views in the Planning Portal (Classic, Detail and Summary), 
allow users to view their data using hierarchies. However, Classic mode 
cannot be run if On Fly hierarchies are applied.

Using the My View panel, you can a scenario using a specific hierarchy by 
selecting the type of hierarchy (Mode field), the specific hierarchy name 
(Hierarchy field) and which level you wish to view (Level field).
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3-7: Show Hierarchy

Use this check box to indicate whether or not to display the data in the 
Detail View using a tree format if the level in the Tree Level option is not 
the lowest level in the hierarchy.

3-8: Level

Once a hierarchy has been selected from the Hierarchy drop-down 
above, the Level drop-down will populate with all the levels available for 
that hierarchy. Previously referred to as “Tree Level”, this field allows you 
to select the level of the scenario to which the hierarchy will be applied.

3-9: Conversion

This selection defines the unit of measure for the display: 

 Units
 Any Conversion factor already configured

For example, if you have a price for an item and would like to view the 
price in dollars, you can do this by using View By to convert your data to 
revenue by taking the data and multiplying it by price.

3-10: Field View

Enables you to select the Field View and if you have multiple Field Views 
assigned, you can select a different one. 

Field Views are assigned to you by your administrator and you can create 
your own customized Field Views on the My Settings page. This feature is 
explained in more detail in the section titled “Field View” on page 86 of 
this guide.
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3-11: Cmd Bar Show

Use this check box to indicate whether or not to display the Command 
Bar. The Command Bar is a tool bar at bottom of the Data Views which 
gives you access to Cut, Copy and Paste functionality.

3-12: Data View

Enables you to select the Data View and if you have multiple Data Views 
assigned, you can select a different one. 

Data Views are assigned to you by your administrator and you can create 
your own customized Data Views on the My Settings page. This feature is 
explained in more detail in the section titled “Data View” on page 88 of 
this guide.

3-13: Order

Enables you to sort your data in ascending or descending order based on 
the selected data field. Select a field from the drop-down and use the 
radio buttons to change the sort order.

3-14: Show Calendar

Enables you to set everything to a month offset. Use the negative values 
to indicate historical data.
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3-15: Start Date/End Date

These two fields are used to specify the date range you wish to view in 
the selected Data View. Select a month from each field and only data 
falling in between the two dates will be displayed. Data from the selected 
months will be included in the view.
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Section 4: Data Browsing

Data browsing refers to the three different views PP provides to allow you 
to view the data you have selected: Detail, Summary, and Classic.

To change views, use the links at the top of the page to switch to another 
view:

Data Browser 
View

Description

Detail View Focuses on one item at a time with the hierarchy tree 
displayed. For more information, see “Detail View” on 
page 37.

Summary View Focuses on multiple items. For more information, see 
“Summary View” on page 44.

Classic View Focuses on one item at a time. For more information, 
see “Classic View” on page 47.
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4-1: Using Hierarchies

All three views in the Planning Portal, Classic, Detail and Summary, allow 
users to view their data using hierarchies. However, the Classic view can 
only be used with Static hierarchies. If an On Fly hierarchy is applied, the 
Classic View will not display and you will receive an error message.

Static hierarchies need to be removed by the scenarios owner, but you 
can switch from one hierarchy to another using the On Fly hierarchies as 
much as you need. You will be able to change your hierarchy settings 
anywhere the Data View settings section is available to you, and the next 
time you open your Data Browser the changes will be reflected.

4-2: Notes

All three views in the Planning Portal (Classic, Detail and Summary) allow 
users to view notes, enter new notes, or see the history of each existing 
note in a series. 

The Note Editor can be accessed by clicking on the  or  icons:
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4-2-1: Add a Note - Editor Tab

The Editor tab is used to enter new notes and is comprised of the 
following sections.

 Text area - This is used to enter the text for the new note.

 Reason - This drop-down list contains various reasons for why the 
note was entered. These reason codes are maintained by the system 
administrator.

After entering the Note Text and selecting the reason for the note, you can 

click the  icon to save the note.

Adding Notes in Hierarchies

When you view your data using a hierarchy, Static or On Fly, notes can be 
saved at any level in a hierarchy and these notes will persist even after 
you close your scenario or remove your hierarchy. Notes at higher levels 
will not be displayed if levels change in a hierarchy.

When you enter a note at a higher level notes will also be copied down to 
the lowest level series where the note was created. You can use the 
Parent and Parent level fields in the Notes History section to view at 
which level the note was originally created.
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4-2-2: View Notes History

This section is used to view all notes entered by all users.

The following table details each of the sections available on the History 
tab of the Notes Editor:

Column Description

Note This field contains the note that was entered.

Created by The user account that created the note.

Created on The date and time the note was added.

Reason The reason code that was assigned to the note when it 
was created.

Hierarchy This field contains the hierarchy name applied in the 
scenario when the note was entered. This field is blank 
for series in the lowest level of detail or if the scenario 
does not have a hierarchy applied.
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Parent This field shows the series description of the higher 
level series in which the note was added and then 
copied down. If the Note was entered at the current 
level, this field will display the description for the 
current series.

Parent Level This field will show the hierarchy level of the parent 
series where the note was added and then copied 
down to another level. If the Note was added at this 
level, this field will display the hierarchy level of the 
current series.

Column Description
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Section 5: Detail View

In the Detail View, individual items can be viewed with the hierarchy tree 
displayed.

5-1: Detail View Highlights

 User Interface mimics the DME Viewer.

 From the My View panel, you can choose whether or not to view 
the hierarchy (default value is “Yes”).

 Left-side panel displays the hierarchy tree.

 Upper panel displays a graph (either Line or Bar).

 Lower panel displays the data in a grid.

5-2: Working in the Detail View

The following icons are used in the Detail View and allow you to change 
how this screen is displayed, as well as update the data displayed. These 
icons appear on the right-hand side of the screen above the Data panel.

Table 2-1: Detail View Icons

Icon Function

Display/Hide Series - Click this icon to hide the Series 
panel from the Detail View. Click again to restore the 
Series panel to the view.

My View - Opens the My View panel which allows you 
to change the current settings used to display your 
data. For more information on using the My View 
panel, please refer to the section titled “My View 
Settings” on page 26.

Display/Hide Detail Chart - Click this icon to show or 
hide the Line Chart and Bar Graph tabs from view.
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Notes Viewer - Click this icon to open the Note Editor, 
which allows you to add notes to the current series or 
view any existing notes. For more information on using 
the Notes Editor, please refer to the section titled 
“Notes” on page 33.

Save - Click this icon to save any changes you entered 
in the Data panel.

Cancel - Click this icon to cancel any changes you 
entered in the Data panel.

Refresh - Click this icon to refresh the graphs in the 
Line Chart and Bar Graph tabs to reflect changes you 
made in the Data panel.

Table 2-1: Detail View Icons

Icon Function
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5-3: Navigating in Detail View

Click the Detail link at the top of the screen to display the data based on 
the current My View settings. 

1. In the Aggregate View section in the left-hand pane, click on the 

icon to expand the list.
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2. Click on the buttons above the Graph View 
to scroll through the items in the hierarchy.

3. You can also temporarily hide the Series panel by clicking the Show/

Hide Series icon  above the Data panel. Click the icon again to 
show the Series again.

5-4: View and Edit an Opinion Line in Detail View

The Bar Graph in the top panel of the screen shows a graphical 
representation of the current data.

1. You can modify certain lines in the Line Graph depending on your 
setting in the Data View by clicking on and dragging the lines. To 
undo any changes you have made, click the Undo button.

2. Click the button to save your changes.

3. On the Data tab at the bottom of the screen, you can manually edit 
the data directly in the cells.
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4. Click the Properties tab to view the properties. You can edit the 
information displayed on the Properties tab based on the settings in 
the Field View.

5. Click on the Bar Chart tab to view the data represented as a bar chart.

The Bar Chart displays.

6. You can modify any line in the Bar Graph by clicking on and dragging 
the bar to make changes to the forecast. To undo any changes you 
have made, click the Undo button.
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7. Click the  icon when finished to save your changes.

8. You can also add notes to series while in the Detail view by clicking 

this icon: . If a note has already been added to a series this icon 

 is displayed next to the series name. Place your cursor over the 
icon to view a tool tip with the last note added or click on the icon to 
view a detailed list of the notes history.

5-5: Display/Hide Detail Charts

Planning Portal also allows you to hide the Line Chart and Bar Charts and 
only display the Data tab. Hiding these charts is especially useful during 
planning since these graphs would not be used.

Click the Display/Hide Detail Charts icon  above the Data and the 
graphs will be hidden and the Data panel moves to the top of the screen.

Click the Display/Hide Detail Charts icon again to display the graphs and 
move the Data panel back to its original location.
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5-6: Update Data Settings

You can update the settings to change the data displayed by clicking the 

My View icon  above the Data panel. The My View panel displays at 
the right of the screen and allows you to update the parameters of the 
data displayed in the Detail view.

Make any necessary changes to the parameters and click the Apply 
button. The Data is updated and refreshed in the Detail view.

5-7: Export to Excel

1. Click on the icon to export the data to Excel.

After you export to Excel, you can make edits in Excel. However, 
ensure that all cells in Excel are number formatted to “General”. 

Note: The only way to Export to Excel in the Detail View is with the Excel 
icon, located next to Aggregate View in the left-hand pane. This 
feature needs to be Enabled by your System Administrator.
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Section 6: Summary View

In Summary View, data for multiple items can be viewed.

6-1: Summary View Highlights

 Spreadsheet format

 Columns are adjustable

 Attributes are frozen on the left, when the scroll bar is moved.

 Can toggle an item between Summary View and Detail View

 Export to Excel

6-2: Navigating in Summary View

The picture below is an example of the Summary View.
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1. From the Page drop-down box, select the page number to scroll 
through the list.

Alternatively, use the  arrows to scroll through the pages.

2. Use the Items per page drop-down to configure the number of 
records you wish to display on this View.

3. Click the button to update the data with your changes.

6-3: Edit and View an Opinion Line in Summary View

Summary View displays data in grid format and allows you to click in any 
enabled cell to manually change its data.

1. Edit the data in the cells by clicking on the field and making your 
changes.

2. Use the Filter Customer From drop-down box to filter the data by any 
of the listed Attributes.

3. Click the  icon to save your changes.

4. You can also add notes to series while in the Summary view by 

clicking this icon: . 

If a note has already been added to a series the icon for the note will 

look like this . Hover the cursor above the icon to view a tool tip 
with the last note added or click on the icon to view the detailed list of 
the notes history for this series.

5. To view the an item in Detail View, click on the  icon next to the 
item.
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This icon is used to display the selected item in the Detail View. 

6. To go back to Summary View, click on the  icon next to the  
icon in the Data Selection heading. This icon will not display in the 
standard Detail View.

Note: The PP does not show a tree in Summary View. If you want to see the 
tree, switch to Detail View.

6-4: Export to Excel

1. Click the  button to export an item to Excel.

2. Alternatively, click the  button to export all items to Excel.

3. After exporting, you can make edits or reformat the data in Excel. 
However, ensure the cells in Excel are number formatted to 
“General”.

Note: In a Scenario with Daily Observations, the Excel file does not export 
all columns. This is an Excel limitation, as it only supports 256 
columns.
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Section 7: Classic View

7-1: Classic View Highlights

 Ability to Drill Up or Drill Down in a hierarchy.

7-2: Navigating in Classic View

The depiction below is an example of Classic View.

The Series fields are on displayed in the Field column and the Opinion 
Lines are displayed in the Opinion column. You can only edit information 
that is displayed in the white text boxes.

1. Click on the  icons to browse through the data.

2. Use the Series Per Page drop-down to select how many series you 
want to display.

3. To jump to a specific page, select the page number from the Go To 
Page drop-down list.

4. Click the  button to refresh your page.
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7-3: View and Edit an Opinion Line in Classic View

Note: When the filter/permission applies to a tree, the parent is 
automatically selected in the tree view of the Detail View if the lowest 
level item is selected. Though it makes the tree consistent, it 
introduces inconsistencies among the Classic View, Detail View and 
Summary View; this is by design.

1. In the grid, enter the new value in the white text box.

2. Click on the  link above the grid to view the data in 
Line Graph view in a new browser window.

You can modify any of the lines in the Line Graph by clicking on and 
dragging the lines to reflect the new value. Click the Submit button to 
save these changes.

To undo any changes you have made, click the Undo button.

Click the Close Window link to exit this browser view.
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3. Click on the  link above the grid to view the data in 
Bar Graph view in a new browser window.

In the Bar Graph view, you can click and drag on the bar itself to 
make changes to the forecast. When finished, click the Submit 
button to save your changes.

To undo any changes you have made, click the Undo button.

Click the Close Window link to exit this browser view.
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The Data Browser updates the data. By default, the Data Browser 
displays 10 series per page. 

4. Click the Save button to save your changes.

5. Click on the  icon to drill down to lower levels of the 
hierarchy. Alternatively, if you are in a lower level of the hierarchy, 

click on the icon.

Drilling Down pushes the information into lower levels of the 
hierarchy, where you can see greater detail.

Drilling Up pushes the information into the higher levels of the 
hierarchy, where you can see more consolidated data.

Note: If you enter the Classic View from the middle level of the hierarchy, you 
cannot Drill Up to a higher level.

6. You can also add notes to the selected series by clicking 

the  icon 

7. Click Save when finished. Alternatively, click Undo to undo the 
changes you made.

8. You can also add notes to series while in the Summary view by 

clicking this icon:  to open the Note Editor window.
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If a note has already been added to a series the icon for the note will 

look like this . If you hover above the icon you will see a tool tip 
with the last note added or click on the icon for a detailed view of the 
notes history.

Note: Depending on your settings, your modifications can be automatically 
rebalanced within the hierarchy. Please see your System 
Administrator for additional information.
Rev 1 51



Chapter 2
Section 8: Planning Portal Tools

This section details the features available on the Tools menu in the 
Planning Portal. Your System Administrator can configure your user 
permissions and grant you access to these features. 

The table below describes what each option means. Each option is also 
discussed in more detail later in this chapter.

Table 2-2: Planning Portal Tabs

Option Description

Filter Enables you to limit the displayed series to those 
meeting defined criteria.

Reports Enables you to create, view and edit Reports.

New Item When a new series is forecasted, it can be added in the 
New Item area by entering the SKU number and 
selecting the item’s Attributes from a drop-down list.

Mass Adjust Apply Forecast adjustments to multiple series.

Promotions Enables you to add sales Promotions to the forecast.

Profile Settings Enables you to apply a pattern to a series forecast to 
compensate for either predictable growth or a 
decrease in a product's demand that is not captured by 
most statistical forecasting methods.

Retagging Enables you to copy history, forecast, or any other 
Opinion Line from an old series to a new series.
Rev 1 52



Chapter 2
8-1: Filter

The Filter option on the Tools menu allows you access to view, create, 
edit or delete filters that can be applied to your data. Once created, these 
filters can be selected in the My Views section, allowing you to apply 
these filters without having to repeatedly enter the criteria.

8-1-1: Filter Management

You can view, create, edit or delete your filters on the Filter Management 
screen. The Filters drop-down menu contains all the existing filters to 
which you currently have access.

8-1-2: View Filters

1. Select the filter you want to apply and click the View button.
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The series displays in the Detail View with the filter applied.

2. Click the My Views icon  above the grid on the Data tab.

3. On the My Views panel, you will see the same filter is selected. You 
can make changes to any of the criteria in the My Views panel and 
click Apply to update the data.

Note: Making changes to the criteria on the My Views panel will not impact 
the criteria for the saved Filter.

4. You can select another filter to apply from the drop-down in the My 
Views panel and click Apply to update the data.

8-1-3: Create Filters

1. On the Filter Management screen, click the Create button.
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The Filter criteria displays in the panel below the buttons:

2. Enter the name of the new filter in the Filter Name field.

3. Enter the details for the new filter in the Description text field.

4. Use the fields in the Definition section to select the rest of the criteria 
for this filter. Click on the drop-down and select the check boxes 
corresponding to the options you want to use in the filter.

Note: The options in these fields are configured by the System 
Administrator.

5. Click Save to save the filter or click Submit to execute without saving.
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8-1-4: Edit Filters

1. Select the filter you want to edit from the drop-down and click the Edit 
button.

The current Filter criteria are displayed below.

2. Make any necessary changes to the name of the filter in the Filter 
Name field.

3. Edit the details in the Description text box, if necessary.

4. Make any necessary changes to the Filter Definition fields.

5. Click Save to save the filter or click Submit to execute without saving.
Rev 1 56



Chapter 2
8-1-5: Delete Filters

1. Select the filter you would like to delete from the drop-down and click 
the Delete button.

2. Click OK to delete the filter or click Cancel.

8-2: Reports

The Reports Management page can be accessed from the Tools menu 
and enables you to view the Aggregate Report data. In addition, you can 
save your report criteria to run again in the future, as well as edit or delete 
existing saved reports. ONce a report has been saved, you can display a 
link to it in the My Reports panel on the Home Page.

Depending on the configuration of your User ID, you may need to contact 
your System Administrator to make the Reports features available.
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8-2-1: Report Management

You can view, create, edit or delete saved report criteria on the Reports 
Management screen. The Report drop-down menu contains all the 
existing saved reports to which you currently have access.

8-2-2: View Reports

1. Select the report you want to display from the drop-down list and click 
the View button.

A blank Aggregate Report window displays.

2. Select the year from the Year drop-down box.

3. Select the viewing criteria from the View By drop-down box.
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4. Click the Show button to view your report. t.

5. Use the Pages field to scroll through the pages of the report or to 
jump to a specific page in the report.

6. You can also select the number of items you wish to view per page 
using the Items per Page drop-down. The default setting is 25 items 
per page.

7. Click the Export button to export the report data to Microsoft Excel.

8. If you need to change the Year or View By settings, click the Show 
button again to update the data.

9. Click the Close button when finished.
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8-2-3: Create a Report

1. On the Report Management screen, click the Create button.

The Report definition is displayed below.

2. Enter a name for the new report in the Report Name text box.

3. Make your selections from each selection box. To select multiple 
options from one category, press the Ctrl key while selecting each 
option.

Note: The selections available are configured by the System Administrator. 

4. In the Report Level area, select one or more Report Level options 
that you have configured. Use the numbered drop-downs to organize 
the options from left to right.

5. In the Opinions section, use the check boxes to select the Opinion 
Lines you want to use in the report. 

6. Use the Calendar Jump drop-down to select the month at which you 
want your data to begin.
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7. Click the Save button when finished.

8. Click the View button at the top of the screen to view your report.

A blank Aggregate Report window displays.

9. Select the year from the Year drop down box.

10. Select the viewing criteria from the View By drop down box.

11. Click the Show button to display the report.

12. Use the Pages field to scroll through the pages of the report or to 
jump to a specific page in the report.

13. You can also select the number of items you wish to view per page 
using the Items per Page drop-down. The default setting is 25 items 
per page.

14. Click the Export button to export the report data to Microsoft Excel.
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15. If you need to change the Year or View By settings, click the Show 
button again to update the data.

16. Click the Close button when finished.

8-2-4: Edit a Report

1. On the Report Management page, select the Report you want to edit 
from the drop-down list.

2. Click the Edit button.

The current criteria displays below.

3. Make your edits as necessary.

4. Click Save when finished.
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8-3: New Item

The New Item feature enables you to create a new series in the Planning 
Portal. You are able to input what you want for your new series. 

8-3-1: Create a New Series:

1. From the New Item Link Management page, select Attributes from 
each drop-down list that you want to apply to your new series.

2. Click the Create button.

3. The “New Item has been created successfully” message displays 
when finished.

If the series already exists, you will get an error message.
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8-4: Mass Adjust

The Mass Adjust page consists of three different features:

 Filter a series

 Select individual series to adjust

 Perform the adjustment

8-4-1: Filter for a Series:

1. Select the filtering criteria you would like to use from each selection 
box. To select multiple options from one category, press the Ctrl key 
while selecting each option.

2. Click the Get Item button.
Rev 1 64



Chapter 2
A list of all of the items that fit your filter are listed in the text box.

3. Select the series listed and move them below by clicking on the Add, 
or Add All buttons. The series you are adding here are the series that 
will be part of your Mass Adjustment.

Alternatively, to remove a series or all series, use the Remove and 
Remove All buttons.
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4. Use the Direction radio buttons to indicate whether you want to 
Increase or Decrease the value of the opinion line.

5. In the Opinion Line area, select the Opinion Lines on which you would 
like to perform the adjustment.

6. The radio buttons in the Adjusted By field are used to indicate 
whether you want to adjust by either a set Percentage or a specific 
Amount.

7. In the Amount field below, enter the numeric value for the amount or 
the percentage you are adjusting.

8. Use the Start Date and End Date fields to select the date range you 
would like to use in the adjustment.

9. In the Kit Adjust section, click Open to open the Kit Adjust feature.
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This feature enables you to set specific values for certain periods. 
There is one field for each period within the date range you specified 
in the Start Date/End Date fields. You must enter a value in each of 
these periods. If any fields are blank, you will get an error message.

10. In the Reason for Mass Adjust text box, enter a description as to why 
you are performing a Mass Adjustment.

11. Click the Apply Adjustment button when finished.

8-5: Promotions

8-5-1: Create a New Promotion

1. From the Promotions page and Properties tab, select the criteria 
you would like to use from the Ads drop down box.

2. Click New.

The Ad Assumption Builder displays with the Customer Name, Mkt 
Code data already entered.
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3. In the First Effective Date and Last Effective Date, select a date 
range.

The # of weeks from production to delivery text box displays the date 
range in weeks.

4. Select the Ad Type from the drop down box.

5. Type in the Percent Ad Lift.

6. Click Create Ad Assumption.

7. Click on the Items tab.

The depiction below is the Items page.

8. Select the items you want available for your Promotion. 

9. Click the Available Items in the Scenario button.

The Available Items are displayed.

10. Select the Items that you would like in your Promotion by checking 
the Set Promo check box.

11. Click Add Items.
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12. Click Display Items for the Ad to view the items.

13. Type in the Weekly Promo Amount Demand in the Weekly Promo 
Amt DMD text box.

14. Type in the Regular Price amount.

15. Type in the Ad Allowance if you would like to apply a discount.

16. Click Save when finished.
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17. Go back to the Properties tab.

18. Click on the Recalc Ad Projection button.

The total Ad Projection is displayed with the changes you had made 
to the items.
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19. Click on Display Promised Dates to display your date range into equal 
percentages.

20. Click on Recalc Dependent Items to recalculate the individual items’ 
Ad Assumptions.

21. Click Commit when finished to save your Promotion to the Living 
Master.
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8-5-2: Updating a Promotion

1. In the Properties tab, click on the Promotion you want to Edit.

2. Change the Date Range or Percent Ad Lift.

3. Recalculate by clicking Recalc Ad Projection.

4. Click Commit to save your changes to the Living Master.

8-5-3: Updating a Promotion Item

1. In the Items tab, click on the Display Items of the Ad button.

2. Make desired changes.

3. Click Save.

4. Click Recalc Dependent Items button.

5. Click Commit to save your changes to the Living Master.

8-5-4: Deleting a Promotion

1. In the Promotions tab, click on the Promotion you want to delete.

2. You will have the option to Open or Delete.

3. Click Delete and confirm.

8-5-5: Deleting a Promotion Item

1. In the Promotions tab, click the Items tab.

2. Click on the Display Items of the Ad button.

3. Click Remove for the items you want to delete.

4. Confirm.
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8-5-6: Changing Promotional Percentages

1. In the Promotions tab, click Properties.

2. Click in Display Promise Dates.

3. Make corresponding changes for percentages.

4. Click Save.

5. Click Recalc Dependent Items button.

6. Recalculate by clicking Recalc Ad Projection.

8-6: Profile Settings

The Profile Settings feature is used to configure the Profile Forecast. 
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8-6-1: Filter Items for a Series:

1. Select the filtering criteria you would like to use from each selection 
box. To select multiple options from one category, press the Ctrl key 
while selecting each option.

2. Click the Get Items button.

The items matching your selected criteria are listed in the text box 
below the Get Items button.

3. Select the series listed and move them below by clicking on the Add 
or Add All buttons. The series you are adding are the series that will 
be part of your Profile Forecast.

Alternatively, to remove a series or all series, click on the Remove or 
Remove All button.
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4. Click on the Properties tab.

5. In the Apply In area, select one of the three options:

Option Description

Selected Series Series you have selected from the Items tab.

Whole Tree Scenario in addition to everything in the hierarchy.

Scenario Entire Scenario.

6. In the Affected Data Field section, select from the available opinion 
lines. The available options listed here are configured by the System 
Administrator.
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7. From the Profile Scenario drop-down, select which scenario contains 
the profiles.

8. In the table below, select a Profile from the drop-down box for each 
row. There is one series listed for each series in your profile scenario. 

9. Specify the date range for this profile using the Start/End drop-down 
boxes.

10. Check the Offset box if you want it to offset to the Profile Start.

11. Enter a value in the Total text box that you want to apply across the 
selected range.

12. Use the Profile Start drop-down to indicate the date this profile 
becomes active.

13. Check the Profile Recycle box if you want the profile to cycle over the 
date range.

14. Click the Apply Profile button to apply these settings to the selected 
items.

15. Click the Save Profile button to save these settings for future use.
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8-7: Retagging

Retagging enables you to copy history, forecast, or any other Opinion 
Line from an old series to a new series.

8-7-1: Add tab

The Add tab enables you to tag information from an old series to a new 
series.

1. On the Add tab, select the Date Range from the drop-down box. The 
available options are:

 Retag historical data only

 Retag forecast data only (will only affect future periods)

 Retag history and forecast
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2. Specify the date range by selecting the Start Date and End Date.

Note: In the DME Viewer, retagging allows you to have empty start and end 
dates. In the Planning Portal, the user must specify both dates.

3. Use the fields in the Source and Target sections to set up the 
mappings between the source series and the target series.

4. Select the Item Number to use as the Source from the drop-down list.

5. Click the View button to display the name of the source series in the 
field below.

6. The “Retain XXX% after retagging” field below the source series is 
used to indicate the amount of the Opinion Line that will be left in the 
series after Retagging is run.

7. The “Reforecast source series” check box indicates whether or not 
the source series is reforecasted after Retagging runs.

8. On the Target side, select the Item Number to use as the target series 
from the drop-down list.

9. Click the View button to display the name of the target series in the 
field below.

10. The “Allocate XXX% to new product” field is used to indicate how 
much of the source series data is mapped to the target series.

11. The “Reforecast target series” check box indicate whether or not the 
target series is reforecasted after Retagging runs.

12. Select the “Reset target series” check box to reset the target series to 
zero before running Retagging. If unchecked, the from the source 
series is added to the target series. In other words, the target series 
retains its history in addition to the source series history.

13. Click View to display the Opinion Lines.

14. Click Save to save your retagging.
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8-7-2: View Tab

From the View tab, you can filter and display either the Source series or 
the Target series.

1. On the View tab, select either Source or Target in the Show Retags 
where area.

2. Use the drop-down lists to select the criteria for the Retagging you 
would like to view.

3. Click the Lookup button to populate the second drop-down lists.

4. Click the Search button.

The grid displays any saved Retaggings that match your search 
criteria.

8-7-3: Run Retagging

1. Select the Retag check box if you want to run the Retagging.

2. Click Run.
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8-7-4: Delete Retagging

1. Select the Delete check box for the retagged entry you want to delete.

2. Click the Delete button.

3. You will be prompted to confirm the deletion. Click Yes to delete the 
entry.

4. The retagging entry is removed from the list.
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Section 9: My Settings

The My Settings section of the Planning Portal allows you to personalize 
the interface with your own default selections. These settings will be 
applied automatically each time your User ID is used to log in to the 
system.

Each tab allows you to customize a different portion of the Planning Portal 
to best suit your needs and will prevent you from having to apply these 
settings manually each time you access the system. 

Each tab and the available options provided are detailed in the sections 
below. The Home Page tab will always display first.

9-1: Home Page

The Home Page tab allows you select which panels are displayed by 
default when logging into the Planning Portal. Use the check boxes to 
select which panels will display automatically. You will still be able to click 
the bars on the Home Page to add or remove panels.
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9-2: My Notes

This tab is used to indicate the types of notes displayed on the Home 
Page in the My Notes panel. Essentially, you can create a filter to indicate 
that you want to view notes created by specific users, at a specific level, 
and during a specific time frame. 

The left-hand panel displays the User Permissions section, which allows 
you to indicate that you want to display notes created by a select group of 
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users. Use the check boxes in the Selected column to indicate the 
individual users who created the notes that will be displayed.

Use the criteria in the right-hand panel to indicate the specific types of 
notes you want to display.
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Use the check boxes at the top of the section to indicate if you want to 
view notes entered at the Series or Observation level. Both check boxes 
can be selected simultaneously.

In the Time Range section, there are three options for providing a date 
range. Using these ranges will only display notes entered during the 
specified time frame:

 Sliding: Use the drop-down to select a set time frame such as 
Today, Yesterday, Last Week, or Last Month. The dates covered 
by these time frames will always be re-calculated based on the 
current date.

 Fixed: Use the two date fields to indicate the start and end dates 
for the range. You can enter dates in MM/DD/YYYY format or 
click on the drop-downs and select the dates from the calendar.

 None: Select this option to include all notes regardless of when 
they were created.

Click the Save button at the top of the panel when finished. The changes 
are applied automatically and the “Save Successfully” message will 
display below the User Permissions field. Only notes meeting your criteria 
will now be displayed in the My Notes Panel of the Home Page.

Note: If you exit the My Notes tab without saving, your changes will not be 
applied.

9-3: My View

The My View tab will always display first by default when accessing the 
My Settings section of the PP. This tab is used to customize the default 
view you want to use when displaying data and corresponds to the 
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settings shown on the My View panel (see Section 3: My View Settings for 
more information).

Shortcuts are basically a saved set of My View Settings. The My View tab 
is comprised of two sections: The Shortcut list and My View Settings. The 
Shortcut list allows you to select a specific shortcut to see the My View 
Settings section. From the My View section you can select the default 
values for each view option.

The My View Settings panel allows you to specify the default value for 
each setting using the drop-down lists in the Startup Default column. You 
can also indicate whether or not this setting will display in the My View 
panel using the check boxes in the Show Always column. Only fields with 
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a checked box will display in the My View panel when the settings are 
displayed.

Click the Save or Save As buttons at the top to save your changes. The 
changes are applied automatically and the “Save Successfully” message 
will display at the top of the My View Settings panel.

Note: If you exit the My View tab without saving, your changes will not be 
applied.

9-4: Field View

The Field View tab allows you to see the settings for any current views to 
which you have access and to create your own custom Field Views. Once 
created, these Field Views will display in the Field View drop-down of the 
My View panel and can be used to filter your data.

System administrators can grant users permissions to use other Field 
Views that give you access to series attributes. These Field Views are 
extensive and show a lot of data that may need to be filtered even further. 
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Users can create their own custom Field Views based off of existing Field 
Views to which they have access. This allows you to define the exact data 
lines and attributes you want to focus on.

9-4-1: Create a Field View

1. Select an existing view from the Field View List panel at the left. 

The Field View Settings panel to the right displays the list of available 
fields to use. 

2. Use the check boxes in the Selected column to choose the fields to 
include in the view.

3. Enter a descriptive title for this new view in the Name field above the 
Field View Settings.

4. Click the Save button.

The new view is saved and added to the tree in the Field View List.

5. The new view can now be selected from the Field View drop-down on 
the My View panel and applied to your data.
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9-5: Data View

The Data View tab allows you to see the settings for any current views to 
which you have access and to create your own custom views. Once 
created, these Field Views will display in the Data View drop-down of the 
My View panel and can be used to filter your data.

System administrators can grant users permissions to use other Data 
Views that give you access to series attributes. These Data Views are 
extensive and show a large amount of data that may need to be filtered 
even further. Users can create their own custom Data Views based off of 
existing views in order to define the exact data lines and attributes you 
want to view.

9-5-1: Create a Data Views 

1. Select an existing view from the Data View List panel at the left. 

The Data View Settings panel to the right displays the list of available 
data lines to use.

2. Use the check boxes in the Selected column to choose the data lines 
to include in the view.
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3. Use the check boxes in the Display Graph and Display Summery 
columns to indicate if the selected data lines will be available in the 
Graph and Summary sections.

4. Enter a descriptive title for this new view in the Name field above the 
Data View Settings.

5. Click the Save button.

The new view is saved and added to the tree in the Data View List.

6. The new view can now be selected from the Data View drop-down on 
the My View panel and applied to your data.

9-6: My Charts

The My Charts tab is used to configure the different types of graphical 
representations of the data you can display on the Home Page. Planning 
Portal allows you to select from eight different types of charts and graphs 
that you can display on the My Charts panel of the Home Page.
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1. Enter the name and description for the chart being created. The 
Name of the chart will display in the drop-down list on the Charts 
panel on the Home Page.

2. Use the Type drop-down to select the kind of chart being created. 
Possible options are: 

 Column

 Stacked Column

 Bar

 Stacked Bar

 Line

 Pie

 Doughnut

 Concentric Doughnut

3. Use the check boxes to select the Opinion Lines you want to use to 
generate the charts. You can select multiple opinion lines for each 
chart.

4. In the Date Range field, you can set the time frame for the data used 
to generate the chart. You can choose either a Fixed range (specific 
start and end dates) or a Sliding range (for example, a six month 
range that varies based on the current date).

5. Use the Group By radio buttons to indicate whether the data is sorted 
based on either the Series Attribute or the time Period.

6. Use the drop-down to select the specific Series Attribute to group by. 
This field is only active if the Series Attribute option is selected in the 
Group By field.

7. Use the Default View drop-down to apply a custom view to the data 
when creating the chart.

8. Click the Preview button to see a sample version of the chart you 
defined.
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9. Click Save when finished.

10. The new chart can now be selected and displayed on the Home 
Page.

9-7: Custom Task

This tab will allow you to run Custom processes that were defined in the 
DME Viewer from the Planning Portal.

Note: Depending on the permissions the system administrator has assigned to 
your user account this feature might not be enabled.

9-7-1: Run a Custom Task

If you have been given access to this feature, these are the steps you 
need to follow to run a custom task:

1. Click on the Custom Task tab in the My Settings section and the 
Custom Task window will display:

2. Select the custom task to run from the Available Custom Tasks 
drop-down list.
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3. Once you picked your Custom Task the default values for the 
parameters will be populated automatically, but can be changed 
manually if necessary.

Each task may have different parameters so these values may 
change from task to task.

4. Once your parameters are set, you can run the task by clicking the 
Execute Task button. 

The “Task executed successfully” message will display at the bottom 
of the screen. If the task is not run successfully, any errors that 
occurred will be displayed.

9-8: Exception

9-8-1: Exception Management

The Exception Management link enables you to manage all of the 
Exceptions available and to assign them to specific users. Exceptions can 
only be created by the System Administrator in the Viewer. Exceptions 
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can be assigned in the Planning Portal. After clicking on the link, the 
Exception Assignment window displays.

1. From the drop-down boxes shown above, select the following criteria 
for your Exception:

 User 

 Exception Name

 Scenario

 Level (0-8) - It is recommended that you run your Exceptions at 
the lowest level (0).
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2. Click the Add button. The criteria is then listed under the User, 
Exception, Scenario, and Level columns.

To remove the criteria, select the criteria you would like to remove 
from the drop-down boxes and click the Remove button.

The information is then removed from the column.

3. You can also filter by any column, but clicking on a column header 
and dragging it into the toolbar above the grid where it says “Drag a 
column here to group by that column”.

4. The exceptions will then be grouped by that header as shown below:
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